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Chapter 1: Introduction

Welcome to the Pro Tools® | S3 studio controller and Ethernet AVB 4 in/6 out audio interface from Avid®. The S3 uses Avid’s 
high-speed EUCONTM (Extended User Control) control protocol to enable fully integrated control of Pro Tools® | Software and 
other EUCON-compatible audio and video applications via a 100 MB/s Ethernet connection. The same Ethernet connection also 
provides Ethernet AVB audio connections between the on-board audio I/O on the S3 and the workstation computer. 

The S3, when connected to an E3 engine and up to four Stage 16 remote stage boxes, is also the central controller for the 
VENUE | S3L-X live digital mixing system.

EuControl Software
EuControl lets your workstation computer find, link, and communicate with the S3 via the EUCON protocol. EuControl also lets 
you set preferences for and customize the controls on your S3. EuControl software must be installed on the workstation computer 
before you can use the S3 with your application. 

Ethernet AVB Audio
(AVB-compatible Mac Running OS X 10.9.x and Higher Required)

Ethernet AVB audio is a high-fidelity, low-latency Ethernet audio protocol used to connect the on-board audio I/O on S3 to your 
Core Audio- and AVB-compatible workstation computer. AVB audio must be enabled on the workstation computer before you can 
use the I/O on the S3 with your applications. See S3 Audio I/O Connections for more information.

See the VENUE | S3L-X System Guide for more information.
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What’s Included
• S3 control surface

• Power supply with IEC cable

• Documentation pack, which includes the EuControl software Activation Card, S3 Welcome Letter, Health and Safety Guide and 
a warranty card

Additional Required Equipment
• Shielded Cat 5e (350 MHz) or better Ethernet Crossover cable(s)

Optional Equipment
• A standard Ethernet router or switch (for control surface functionality only)

• A qualified AVB-compatible Ethernet switch (for audio I/O and control surface functionality)

System Requirements and Compatibility
One S3 control surface can be used with EuControl Software at a time. One S3 can be used in conjunction with one Artist Transport 
at a time. Avid can only assure compatibility and provide support for hardware and software it has tested and approved. For com-
patibility information and other resources, visit:

www.avid.com/S3-Surface-Support

Registration
Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. 
By registering, you become eligible to receive the following:

• Technical support information

• Software update and upgrade notices

• Hardware warranty information

About This Guide
This guide covers using the S3 control surface with Pro Tools and other EUCON-compatible applications. 

If you bought the S3 as part of a VENUE | S3L-X system, see the VENUE | S3L-X System Guide for information on what’s included.
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Conventions Used in This Guide
All of our guides use the following conventions to indicate menu choices and key commands:

The names of Commands, Options, and Settings that appear on-screen are in a different font. 

The following symbols are used to highlight important information:

Hardware Switches on S3 Control Surface
The names of switches on the S3 control surface are in bold, such as Sel. The two Surface SHIFT switches on the S3 are indicated 
by bold text, in all-caps to distinguish it from references to the Multi Select/SHIFT Global Modifier switch and the Shift key on 
your computer keyboard.

Surface SHIFT
The Surface SHIFT switches on the S3 are used in conjunction with other keys to access secondary functions. Some switches have 
secondary functions, highlighted in gray above the primary function (such as < Bank/Home, where Home is the secondary func-
tion). The following terminology is used to describe SHIFT functions.

Example:

• “Press and hold the Surface SHIFT switch then press the Bank/Home switch”

is written as

• “Press Surface SHIFT + Bank/Home”

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse button

Right-click Click with the right mouse button

User Tips are helpful hints for getting the most from your system.

Important Notices include information that could affect your data or the performance of your system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid guides.

Surface SHIFT switch (left) and the Multi Select/SHIFT switch (right)
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How to Use this PDF Guide
These are some useful features of this PDF:

• The Bookmarks on the left serve as a continuously visible table of contents. Click a + symbol to expand that heading to show 
subheadings. Click the – symbol to collapse a subheading. Click on a subject heading to jump to that page.

• The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it 
turns into a finger. Then click to locate to that subject and page.

• Any text entry in blue is an active link. Click on the link to go to that section.

• Select Find from the Edit menu to search for a subject.

About www.avid.com
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your system. 
The following are just a few of the services and features available. 

Product Registration Register your purchase online. 

Support and Downloads Contact Avid Customer Success (technical support); download software updates and the latest online 
manuals; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide 
Avid community on the User Conference. 

Training and Education Study on your own using courses available online or find out how you can learn in a classroom setting 
at a certified Avid training center. 

Products and Developers Learn about Avid products; download demo software or learn about our Development Partners and 
their plug-ins, applications, and hardware. 

News and Events Get the latest news from Avid or sign up for a demo.
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Chapter 2: Installation and Setup

This chapter shows how to get your S3 set up as a studio controller, and consists of the following steps:

Connecting S3
First, connect your S3 directly to your workstation computer (the computer running Pro Tools or other DAW), or connect to a 
router that is then connected to your workstation computer, then power on S3.

To connect your S3 to your workstation computer:

1 Connect the female end of the AC power cord into the power adapter and the male end into a power outlet. Make sure the AC 
power cord is pushed all the way into the adapter.

2 Connect the DC output cable from the power adapter to the DC In jack on the back panel. 

• Connecting S3

• Installing EuControl Software

• Enabling EUCON in Pro Tools

• Confirming EUCON

Standard routers and switches can be used if you are using the S3 only as a control surface. However, to use the built-in AVB 
audio I/O on the S3, the S3 must be connected directly to the computer or to an AVB-compatible Ethernet switch. Visit 
www.avid.com/compatibility for information on compatible peripherals.

Connecting the AC power cable to the power adapter

Connecting the DC power output cable to the DC In jack
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3 Connect one end of an Ethernet Crossover cable into either of the Network ports on the back panel of the S3.

4 Connect the other end of the Ethernet cable to an available Ethernet port on your computer, or to the computer’s Thunderbolt 
port using an Ethernet-to-Thunderbolt adapter.

5 If you want to connect the S3 to a local area network, or to connect an Artist Transport, connect the Ethernet cable to an Ethernet 
router or switch, and make sure the router or switch is powered on before powering on the S3.

6 If you are connecting to a Mac with two Ethernet ports, we recommend you use Ethernet 1 rather than Ethernet 2. However, if 
you want to use Ethernet 2, do the following on your computer: 

• On the workstation computer, go to System Preferences > EUCON. 

• Click the Network Interface pop-up menu and choose Ethernet 2.

7 Press the power switch on the back of the S3 to the “on” position. The faders jump and the LEDs blink during initialization.
 

8 When the S3 is finished initializing, confirm that the S3 is in Studio Mode, indicated by Studio Mode appearing in the 15th 
top-row encoder display. 

9 Do one of the following depending on the S3’s current mode:

• If the S3 is in Studio Mode, proceed to Installing EuControl Software.

• If Live Mode is shown in the display instead of Studio Mode, proceed to Toggling Studio and Live Modes.

Network ports on the back panel of the S3

An Ethernet-to-USB adapter may also be used, but audio I/O to and from the S3 is not supported.

S3 cannot connect to your workstation computer using a wireless connection. A hard-wired network connection is required.

Top-row encoders showing Studio Mode enabled

If the S3’s current mode does not appear in the two encoder displays after the S3 is powered on, the firmware on your S3 must 
be updated via VENUE Software 4.5 or higher. Connecting the S3 to an E3 engine with VENUE 4.5 or higher installed and pow-
ering on both devices automatically updates the firmware on the S3. See the What’s New in VENUE 4.5 Guide for more infor-
mation.

12V DC

Studio Mode
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Toggling Studio and Live Modes
The S3 operates in one of the two following modes:

Studio Mode Lets you use the S3 with your workstation computer after EuControl software has been installed. If the S3 is in Stu-
dio Mode and is connected to an E3 engine (for use in an S3L live mixing system), the S3 will not be recognized by any E3 engines 
in the network.

Live Mode Lets you use the S3 with an E3 engine as part of an S3L live mixing system. If the S3 is in Live Mode and is connected 
to a workstation computer with EuControl software installed, the S3 will not be recognized by EuControl on the workstation com-
puter.

You can toggle the S3 between modes using the Application/Workstation switch.

To toggle between Live and Studio modes:

1 Power off your S3.

2 Press and hold the Application/Workstation switch, then press the power switch on the back of the S3 to the “on” position.

3 Keep holding the Application/Workstation switch until the two rightmost top row encoder displays (encoders 15 and 16) 
show Live Mode/Studio and OK, respectively.

4 Press the encoder under the display showing Live Mode/Studio once, so that the desired mode appears above and in larger text 
than the other mode in the display. 

5 Press the encoder under the display showing OK. The S3 restarts automatically in the selected mode.

Top-row encoder displays showing mode toggle controls

Encoder display showing Studio Mode enabled

12V DC

...then press the S3 power switch to “On”Press and hold the Application/Workstation switch... 

Top

In

Sel

In

Sel

Config
Back

PageExpnd
Page

Live Mode
Studio

OK

Studio Mode
Live
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Installing EuControl Software
Next, install EuControl software on your workstation computer. An Internet connection is required to download EuControl.

To install EuControl software: 

1 Visit www.avid.com/account and log into your Avid account (or create an account if you don’t already have one) to download 
the EuControl installer for your workstation computer’s platform (Mac or Windows).

2 When download is complete, locate the EuControl installer on your computer and double-click it to mount it (DMG on Mac) or 
uncompress it (ZIP for Windows).

3 In the resulting folder, locate and double-click the Install_EuControl file.

4 Follow the on-screen instructions to complete the installation. 

5 When installation is complete, click Quit (Mac) or Finish (Windows). EuControl software on your computer launches automat-
ically and is running when its icon appears: 

Mac Wait up to 60 seconds. A lit EuControl icon in the menu bar indicates correct installation and your surface is attached in 
EuControl. 

Windows Wait up to 60 seconds. A lit EuControl icon appears in the system tray at the bottom of the screen. If you don't see the 
EuControl icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons.

6 If the lit EuControl icon does not appear, do any of the following: 

• See Add to add S3 manually.

• Click the EuControl icon in the menu bar (Mac) or right-click the choose Restart EUCON Applications (see Restart EUCON 
Applications for more information).

• Shut down S3 and your computer, then turn them on (S3 first, then the workstation computer).

• See www.avid.com/S3-Surface-Support for the most current troubleshooting information.

7 Proceed to Updating S3 Firmware.

Lit EuControl icon in the Mac menu bar

Lit EuControl icon in the hidden icons view of the Windows system tray
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Updating S3 Firmware
After installing EuControl, make sure your S3 is running the latest firmware. The firmware is provided within EuControl, so an In-
ternet connection is not required. 

To update S3 firmware:

1 Click (Mac) or double-click (Windows) the EuControl icon and select EuControl Settings.

2 If necessary, click Surfaces to display the Surfaces tab.

3 Click Avid S3 in the My Surfaces list so it is highlighted. 

4 Click Update Firmware. If the Update Firmware dialog shows a message that the surface is up to date, no further action is nec-
essary. 

5 If the firmware needs to be updated, follow the instructions in the Update Firmware dialog box to proceed, and make sure to ob-
serve the following guidelines when updating firmware:

• Ensure that S3 is connected to a trustworthy power source.

• Do not power off the S3 during the update or attempt to interrupt the update.

The status of the firmware update is shown on the S3 displays as well as in the EuControl dialog. 

6 Click Done when the firmware update is complete, then proceed to Enabling EUCON in Pro Tools.

Surfaces tab 

If S3 does not appear in the My Surfaces list, add it manually. See Add.
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Enabling EUCON in Pro Tools 
When you first connect your S3, you must enable EUCON in Pro Tools, EUCON subsequently remains enabled in Pro Tools unless 
you disable it. To enable EUCON in other DAWs, see the documentation provided by the manufacturer.

To enable EuControl in Pro Tools:

1 Launch Pro Tools. If the Quick Start dialog appears, close it.

2 Choose Setup > Peripherals, and click the Ethernet Controllers tab. 

3 Select Enable EUCON. 

4 Click OK. You do not need to configure any other Ethernet Controllers settings. These settings do not apply to EUCON. 

Pro Tools scans your system until it identifies attached EUCON-compatible hardware. When Pro Tools finishes scanning your 
system, your controllers are ready to use with Pro Tools.

5 Proceed to Confirming EUCON.

Enable EUCON check box
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Confirming EUCON
To confirm installation and communication: 

1 Make sure you have enabled EUCON.

2 Open a session if one is not already open. 

3 Verify that the channel strip displays above the bottom row of 16 encoders (the Channel Encoders) on the S3 show the track 
names for the first 16 tracks in the Pro Tools session. 

4 In the Pro Tools Mix window, verify that the names of the tracks currently banked to the channel strips on S3 are highlighted 
with blue-green borders.

5 Proceed to any of the following:

• For instructions on using your S3 after initial installation, see Powering-On Your System After Initial Setup.

• To connect a second workstation computer, go to Connecting a Second Workstation.

• To connect a footswitch, go to Connecting a Footswitch.

Powering-On Your System After Initial Setup
After the initial installation and setup, your system must be powered on in a specific order, as follows:

1 If connecting to a router, connect S3 to the router, connect the router to the workstation computer, and power on the router.

2 If connecting directly, connect S3 to the workstation computer.

3 Power on the S3.

4 Confirm that S3 is in Studio Mode. Enable Studio Mode if Studio Mode is not enabled (see Toggling Studio and Live Modes).

5 Once S3 is finished initializing, power on the workstation computer.

Channel Encoder displays showing track names (first eight tracks shown)

Pro Tools Mix window showing tracks currently banked to the S3 channel strips

If the S3 is not recognized by EuControl on your workstation computer (for example, because you powered S3 on after pow-
ering on the workstation computer), click the unlit EuControl icon in the menu bar (Mac) or System tray (Win) and choose 
Restart EUCON Applications...to relaunch EuControl and re-initiate the connection.
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Connecting a Second Workstation
The S3 can control applications running on a second computer, referred to in this guide as a workstation. If EuControl is running 
on the same workstation as all your audio/video applications you can skip these instructions. 

To be able to control a second workstation:

1 Transfer the EuControl installer onto the second computer. After downloading, make sure the installer is mounted (DMG on 
Mac) or uncompressed (ZIP for Windows).

2 In the Extras folder, double-click the Install EuCon Workstation installer. 

3 Follow the instructions to install the EuControl Workstation software.

Connecting a Footswitch
The S3 has a 1/4-inch footswitch input on the back panel, which can be used to punch in and out of recording in your DAW. See 
Footswitch for more information on configuring the footswitch.

Footswitch input on the back of S3
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Chapter 3: S3 Surface Controls Overview

This section provides an overview of the surface controls on the S3 when using S3 with EUCON-compatible applications. For spe-
cific S3 workflows, see Using S3 with Pro Tools.

S3 top panel

1 – Channel Strips

2 – Channel Strip Displays

3 – Assignable Channel Encoders

4 – Channel Encoder Assignment Switches

5 – Fader Banking Controls

6 – Bank Switches A–F

7 – Channel Control

8 – Window Navigation Controls

9 – Application/Workstation Switch

10 – Automation Controls

11 – Solo Clear and Mix to Monitors Switches

12 – Surface SHIFT

13 – Modifier Switches

14 – Touchstrip (Transport Controls)

1

2

3

4

5

7

8

9

6

13 14 1212

10

11
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Channel Strips
S3 provides 16 channel strips, each with a display, an Assignable Channel Encoder (each with its own encoder 
Sel and In switches), a Solo switch, a Mute switch, a 100mm motorized touch-sensitive fader, a channel select 
(Sel) switch, a record engage (Rec)/Automation Mode (A) switch, and a level meter.

Channel Strip Display
See Channel Strip Displays.

Assignable Channel Encoder
See Assignable Channel Encoders.

Solo
The Solo switch lights yellow when that track is soloed.

Mute
The track is muted (off) when the strip Mute switch is lit, and is on (unmuted) when not lit.

Fader
The fader controls the level for the track assigned to the channel strip, or the parameter assigned to the Channel 
Encoder if Flip to Faders is engaged. It is motorized so it reflects changes made in the application, such as au-
tomation. It is also touch sensitive, which some applications use for automation.

 When the Select by Touch General preference is selected in the EuControl Settings application (see Select 
by Touch), touching a fader selects that track in the application and attentions it on that strip. This is the same 
as pressing the fader Sel switch. 

 Holding down the Default/ALT switch and touching a fader sets it to unity gain.

Channel Sel and Rec Switches
Each channel strip features a channel Sel, a channel Rec switch, and an automation mode switch (A), which operate as follows:

Sel Selects that track in the application, and attentions it for editing in the Channel Encoders when Channel Mode is enabled (see 
Channel Encoder Modes), and in Channel Control (see Channel Control). A line under the track name in a channel strip display 
indicates the track is attentioned.
.

Rec Record-enables a track in the application. 

• In Pro Tools, the Rec switch flashes red to indicate that track is enabled (armed) for recording, and is lit solid when recording 
is in progress.

• Pressing a lit Rec switch disables that track for recording.

A (Surface SHIFT + Rec) Changes the automation mode for a track.The desired automation mode appears in the bottom 
right-hand corner of the channel strip display or on-screen.
.

In Pro Tools and other applications, multiple tracks can be selected, but only one channel can be atten-
tioned. In this case, the attentioned track is the last one selected.

You can also use the Function (F1–F16) switches to change track automation modes. See Working with Automation.
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Channel Strip Displays
At the top of each channel strip is an Organic Light Emitting Diode (OLED) display. When S3 is first powered on, the Channel En-
coders are in Normal Mode (see Channel Encoder Modes), and each display shows track information as follows:

1 – Meter Shows clip, peak, and normal values. It can show mono, stereo, or surround tracks. 

2 – Track Name Shows the track name as it appears in the application. When a fader is touched, it shows the value of the fader. Af-
ter releasing the fader it reverts to showing the track name.

3 – Track Number Shows the track number relative to its position in the application.

4 – Parameter Name Shows the name of the parameter currently assigned to the corresponding Channel Encoder. When an en-
coder is touched, it shows the value of the parameter. After releasing the encoder it reverts to showing the parameter name.

5 – Encoder Position Shows the relative setting of the control for the currently assigned parameter. 

6 – Automation Mode Shows the track’s current automation mode setting, as follows:

• blank = automation is off

• r = read

• w = write

• rw = read/write

7 – Attention Indicator Indicates that the corresponding track is the attentioned track. Any parameters adjusted using the Channel 
Encoders in Channel Mode (see Channel Encoder Modes) and using Channel Control apply to the attentioned track (see Channel 
Control).

Display Sleep

To preserve display life, the channel displays sleep when not in use.

Channel strip display in Normal Mode

For more information on working with automation on the S3, see Working with Automation.
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Assignable Channel Encoders
Each channel strip has one touch-sensitive, continuously rotating encoder for adjusting parameters as assigned by the Channel En-
coder Assignment switches (see Channel Encoder Assignment Switches). Each encoder can also be pressed, which is typically 
used to access sub-menus. Each encoder also has corresponding Sel and In switches.

• A Channel Encoder Sel switch assigns a secondary function of the displayed parameter to the corresponding Channel En-
coder. For example, engaging the Sel switch for an encoder controlling EQ frequency assigns Q (bandwidth) to that encoder.

• A Channel Encoder In switch toggles two-state parameters, such as turning an individual EQ Band on/off.

Channel Encoder Modes
The Channel Encoders operate in either Normal Mode or Channel Mode. The channel displays shows the current channel mode.

Normal Mode

In Normal Mode, each Channel Encoder controls the same parameter for every track on the channel strips. A line appears under the 
attentioned track’s name in the display.

Channel Mode

In Channel Mode, the 16 Channel Encoders control up to 16 different parameters for the attentioned track. In Channel Mode pa-
rameter names and value are highlight in each channel display. For the attentioned track, track name as well as parameter and value 
are highlighted. 

Channel Mode is useful for editing EQs and plug-ins that have many parameters. 

Basic Channel Encoder Use
When S3 is first powered on, the Channel Encoders are in Normal Mode and Pan is assigned to the Channel Encoders by default. 
Each Channel Encoder controls pan for its corresponding track on the strip.

To quickly access pan control on the Channel Encoders in Normal Mode:

 Press the Pan Channel Encoder Assignment switch.

To enable Channel Mode: 

1 Press a Channel Sel switch to attention that track, then press SHIFT + Flip. 

2 Press the desired channel Encoder Assignment switch

3 To exit Channel Mode, press Shift + Flip again.

Channel displays in Normal Mode, showing “Snare” as the attentioned track

Channel displays in Channel Mode, showing “Snare” as the attentioned track

Pressing the EQ Channel Encoder Assign Switch automatically enables Channel Mode as well.
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Channel Encoder Assignment Switches
The Channel Encoder Assignment switches assign sets of adjustable parameters, called Knob Sets, to the Channel Encoders. A 
Knob Set is an array of controls used by EuControl-compatible applications to control plug-ins, EQs, dynamics, aux sends, and 
other processing functions using the controls on the S3. Some of these Knob Sets also have sub-menus.

One of the switches is always selected, and the associated parameters are assigned to the Channel Encoders until another Channel 
Encoder Assignment switch is pressed. When S3 is first powered on, Pan is selected by default.

The labels next to each Channel Encoder Assignment switch indicate the parameters that can be assigned to the Channel Encoders. 
The text in white represents a switch’s primary function, and the text in black represents a switch’s secondary function. Secondary 
functions are accessed by pressing and holding the Surface SHIFT switch (see Surface SHIFT) then pressing the desired Channel 
Navigation switch.

The following switches are provided:

Input Assigns hardware input parameters such as input routing, mic gains, phantom power, and other application-specific param-
eters to the Channel Encoders.

Insert Assigns the top-level Insert Knob Set to the Channel Encoders. When Insert is pressed, in each channel display for all cur-
rently banked tracks the first insert slot (a) is shown, or a plug-in is shown if one is inserted. Pressing a Channel Encoder under the 
display showing the plug-in you want to adjust enables Channel Mode on the Channel Encoders, and the Knob Set for the selected 
plug-in is assigned to the 16 Channel Encoders for editing. 

 Press the Page > Channel Encoder Navigation switch to access the next plug-in.

 Press the Back Channel Encoder Navigation Switch to return to the Channel Encoders to the top-level Inserts Knob Set. Or, you 
can simply press another Channel Encoder Assignment switch to navigate directly to another Knob Set. 

Dyn Assigns the top-level Dynamics Knob Set to the Channel Encoders. Operation is similar to the Inserts Knob Set, except only 
the first inserted Dynamics plug-in on the channel is displayed and accessed. 

Channel Encoder Assign switches

Primary function (Insert) and the secondary function (Dyn)

The text on the switch itself indicates the parameter that can be assigned to the Channel Encoders when using S3 as part on 
an S3L live system.

Use the Audio Control Encoders to control the S3’s built-in I/O. See S3 Audio I/O Connections for more information.

In the Insert Knob Set, parameters are mapped to the Channel Encoders according to the manufacturer’s specifications. Pa-
rameter mapping can vary between plug-ins, even of the same type.

In the Dyn Knob Set, parameter mappings to the Channel Encoders are standardized across dynamics plug-ins. For example, 
the threshold controls for two compressor plug-ins from different manufacturers appear on the same encoder.

Group Channel

Dyn Mix
Insert Pan

Aux Flip

Input EQGain HPF

Comp Pan

Aux Flip

Dyn
Insert

Comp
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Aux Assigns sends on the Channel Encoders.

 In Normal Mode, the first send is displayed, and pressing the Page > Channel Encoder Navigation switch assigns the next set 
of sends to the encoders.

 In Channel Mode, up to 16 sends for the currently selected channel can be accessed at once.

Group Displays the Group Knob Set to configure group or control group (VCA) membership.

 In Normal Mode, the first group is displayed, and pressing the Page > Channel Encoder Navigation switch displays the next 
group if applicable.

 In Channel Mode, up to 16 groups for the currently selected channel can be accessed at once.

EQ Assigns the top-level EQ Knob Set to the Channel Encoders. Operation is similar to the Inserts Knob Set, except only the first 
inserted EQ plug-in on the channel is displayed and accessed.

Pan Displays the Pan Knob Set to configure stereo or surround panning. Pan controls are not available for tracks with mono or no 
output path assignments.

Mix (Surface SHIFT + Pan/Mix) Displays the Mix Knob Set to configure track output routing.

Flip  Toggles what is currently assigned to the knobs (such as pan or send parameters) to the faders. A vertical double arrow appears 
in the channel strip display when the faders and knobs are flipped. Press Flip again to toggle the faders and knobs back to normal. 
You can use Flip mode with Aux sends, for example, to quickly set up headphone mixes using the faders.

Channel (Surface SHIFT + Flip/Channel) Toggles the Channel Encoders between Normal Mode (unlit Channel switch) and 
Channel Mode (lit Channel switch). In Normal Mode, the attentioned track name is underlined to show which track’s parameters 
will be expanded in Channel Mode.

Channel Encoder Navigation Switches
Since a Knob Set may have more parameters than encoders, use these switches to navigate through available parameters.

Back Returns to the previous Knob Set. Press Back repeatedly to back out of all sub-menus and display the top of the current Knob 
Set.

 Source Shows the input sources for the currently banked channels in the channel strip displays.

< Page, Page > Assigns the previous or next set of parameters to the Channel Encoders. The switches light when there is a previ-
ous or next set to go to. For example, if Send A is assigned to the Channel Encoders, pressing Page > assigns Send B to the Channel 
Encoders.

In the EQ Knob Set, parameter mappings to the Channel Encoders are standardized across EQ plug-ins. For example, high 
band gain controls for two EQ plug-ins from different manufacturers appear on the same encoder.

Flip indicator in OLED display

Channel Navigation Switches
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Fader Banking Controls
Bank tracks to the channel strips using the Bank and Nudge switches. Home and End are shortcuts to the first and last banks, re-
spectively.

Bank and Nudge
The Bank and Nudge switches change which tracks are assigned to the channel strips, as follows:

< Nudge Banks tracks one track to the left. If tracks 2–17 were banked to channel strips 1–16, tracks 1–16 are now banked to strips 
1–16.

Nudge > Banks tracks one track to the right. If tracks 1–16 were banked to channel strips 1–16, tracks 2–17 are now banked to strips 
1–16.

< Bank Banks 16 tracks to the left. If tracks 17–32 were banked to strips 1–16, tracks 1–16 are now banked to strips 1–16. Pressing 
< BANK again does nothing because the first bank is already shown.

Bank > Banks 16 tracks to the right. If tracks 1–16 were banked to strips 1–16, tracks 17–32 are now banked to strips 1–16. 

Mixer and Close
Not all applications support these switches. 

Mixer (Surface SHIFT+ < Nudge/Mixer) Toggles Mix and Edit windows in Pro Tools. 

Close (SHIFT + Nudge >/Close) Closes any open window in the application.

Home and End

Home (Surface SHIFT + < Bank/Home)  Banks tracks 1–16 to the channel strips.

End (Surface SHIFT + Bank >/End) Banks the last set of tracks to the strips. 

Fader Navigation controls

Mixer Close

Home End

Nudge Nudge

Bank Bank
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Fader Layout Controls

Bank Switches A–F
Bank switches A–F let you recall custom fader banks and layouts, as created and stored using the Layouts and Assign tabs of the 
EuControl Settings application. You can recall up to 12 custom fader layouts using the Bank switches A–F. A–F recall mixer lay-
outs 1–6. The Shift layer (Surface SHIFT + Bank A–F) recalls layouts 7–12. See Storing and Recalling Custom Layouts for 
more information.

OK and Cancel Switches
Multi Assign Performs the Do to Selected command. For example, use this to create a send or insert a plug-in on all selected tracks. 
See Assigning a Send to Multiple Tracks for an example.

OK Confirms and closes dialogs, and is the equivalent of pressing the Enter key on a computer keyboard.

Cancel Closes dialogs without making any changes, and is the equivalent of pressing the Escape key on a computer keyboard.

User Saves the current session. 

To save the current session:

1 Press User.

2 Press User again to confirm, or press Cancel to not save.

Fader Layout controls
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Channel Control
The top row of 16 encoders and associated navigation switches is called Channel Control. Channel Control lets you adjust a variety 
of parameters for the currently attentioned track. Channel Control and the bottom-row Channel Encoders operate independently, 
so you can adjust two sets of parameters for a single channel. You can also access controls for the S3’s built-in I/O using Channel 
Control (see S3 Audio I/O Connections for more information).

Each Channel Control Encoder features a corresponding display, a select (Sel) switch, an In switch, and a color-by-function LED. 
Four Channel Control Navigation switches are provided for navigating through parameters. 

Channel Control Navigation Switches (Left)
These switches let you navigate through the available pages of Channel Control parameters. An In (enable/bypass) switch is also 
provided.

The following switches are provided:

Back/Top Backs out of the currently assigned Knob Set.

In Toggles in/out whatever is assigned to the Channel Control Encoders, such as sends and plug-ins. A lit switch indicates that the 
send or plug-in is in.

< Page, Page > Assigns the previous or next page of parameters. These switches light when there is a previous or next set to go to. 

Channel Control showing the top-level Channel Control Knob Set (I/O controls are hidden)

Channel Control Navigation switches

Surface SHIFT + Back/Top returns Channel Control to the top-level Channel Control Knob Set.
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Channel Control Navigation Switches (Right)
These switches provide access to Config mode and the controls for the built-in I/O in Channel Control.

Config Enables Config mode on the Channel Control Encoders, letting you assign plug-ins to tracks, and assign track and send in-
put and output paths. See Routing Track Input/Output and Assigning Plug-Ins for more information.

< Page, Page > Lets you show/hide the Audio Control (controls for the built-in I/O) on the Channel Control Encoders when 
pressed simultaneously. I/O controls are hidden by default. See Accessing Audio Control on the S3 for more information.

Basic Channel Control Use
When S3 is first connected to a session in your DAW, the top-level Knob Set for the currently selected channel is shown in the 
Channel Control displays. The types of parameters that can be spilled to the Channel Control Encoders vary depending on the type 
of channel selected (audio track, instrument track, etc.).

To adjust parameters using Channel Control:

1 Select a track. If multiple channels are selected, the last selected track is the attentioned track, and is the targeted channel for any 
changes made in Channel Control. The name of the attentioned track and its track number is shown in the leftmost Channel Con-
trol display.

2 Press a Channel Control Encoder under the display showing the parameters you want to adjust. For example, to adjust an EQ 
plug-in inserted on the currently selected channel, press the Channel Control Encoder under the display showing EQ.

The parameters are spilled across the top 16 encoders, and the LEDs light to reflect the currently assigned function.

3 To go to a different Knob Set, press the Back Channel Control Navigation switch to return to the top-level Knob Set, then press 
another Channel Control Encoder.

Channel Control LED Color-Coding
Channel Control LEDs are color-coded by function, as follows: 

Config switch and I/O Controls

Channel Control top-level Knob Set, showing the attentioned track in the leftmost display

Channel Control Functions and Corresponding LED Colors

Function Color Function Color

Insert Turquoise (blue/green) Sends Yellow

Input Red Pan Blue

Dyn Green Groups Orange

EQ Purple Mix Amber

Top Config
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Window Navigation Controls
These switches provide navigation for the on-screen software pages and tabs.

View 1 and View 2 Recalls Memory Locations 1 and 2 respectively. If no Memory Locations exist, these switches do nothing.

Arrow Switches (▲ ▼ ◄ ►) Mirror the arrow keys on a computer keyboard.

Application/Workstation Switch
This switch lets you cycle through the available applications and workstations.

Application Toggles between the two most recently used open applications. Hold down Application and press Bank > to cycle 
through all open applications. Hold down the Application key and press < Bank to cycle through applications in the opposite di-
rection.

Workstation (Surface SHIFT + Application/Workstation) Attaches the S3 to another workstation, where applicable. S3 can con-
trol applications running on a second computer, referred to in this guide as a workstation. You must first use EuControl to create 
a list of workstations that this key switches between. See Workstations for more information.

Solo Clear and Mix to Monitors Switches

These switches provide the following functions:

Solo Clear Clears any currently soloed channels.

Mix to Mons Is not currently implemented for DAW use.

Window Navigation controls

Application/Workstation switch

Solo Clear and Mix to Monitors switches

View 1 View 2

Solo
Clear

Mix to
Mons
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Automation Controls 
Function Switches F1–F16

Function switches F1–F8 (F9–F16) provide control over the automation mode for one or more selected tracks in two banks of 
switches. For more information on working with automation on the S3, see Working with Automation.

The following table shows the function of each switch in this section.

To set the automation mode on a single track:

 Press and hold the Function switch for the desired Automation Mode, then select a channel.

To set the automation mode on multiple tracks:

1 Select multiple channels.

2 Press and hold Multi-Select/SHIFT+ ALT, then press the switch for the desired Automation Mode.

The Function Switch LED lights whenever its respective automation mode is selected. In certain automation modes such as Write, 
the LED flashes.

Automation Controls

Switch Automation Function Switch Automation Function 

F1 Write F9 Preview

F2 Read F10 Write to Start

F3 Touch F11 Punch Preview

F4 Off F12 Write to End

F5 Latch F13 Suspend Preview

F6 Auto Match F14 Write to Punch

F7 Trim F15 Write to All/Selected

F8 Automation Window F16 Write to Next

9–16 Toggles switches between banks F1-F8 and F9-F16

Show Me (Eye Icon) Not currently available for S3

1
9

2
10

3
11

4
12

5
13

6
14

7
15

8
16

9-16
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Surface SHIFT
Some switches have secondary functions, highlighted in gray above the primary function (such as < Bank/Home, where Home 
is the secondary function). To access these secondary functions, use either of the two Surface SHIFT switches located at the 
lower-left and lower-right sides of the console surface. SHIFT can be engaged momentarily or latched on.

To engage Surface SHIFT momentarily:

 Press and hold the Surface SHIFT switch.

To latch SHIFT on:

 Press and release either Surface SHIFT switch. Surface SHIFT is lit when engaged; press either Surface SHIFT switch to un-
latch.

Modifier Switches
The Modifier switches provide frequently used shortcuts that can be applied to console actions and software screen interactions. In 
Pro Tools, these switches duplicate the function of the Pro Tools computer keyboard modifiers.

Multi Select/SHIFT Duplicates the function of the Shift key on the computer keyboard.

Default/ALT Duplicates the function or the Option key (Mac) or the Alt key (Windows) on the computer keyboard. 

Fine/CTRL Duplicates the function of the Control key (Mac) or the Windows key (or Start) on the computer keyboard.

Command Duplicates the function of the Command key (Mac) or the Control key (Windows) on the computer keyboard.

Transport Controls
Touch Strip

Transport controls are provided on the four Touch Strip Zones.

To use the Transport:

1 Press and hold Surface SHIFT.

2 Press the following Zones for the various transport functions:

1 (Rewind) Rewinds until released.

2 (Fast Forward) Fast forwards until released.

3 (Play/Stop)  Engages play when the transport is stopped; stops the transport when play is engaged.

4 (Record Arm) Arms the transport for recording.

Surface SHIFT switch

Global Modifier switches

Transport controls

SHIFT

Multi Select
SHIFT

Default
ALT

Fine
CTRL Command

1 2 3 4
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Chapter 4:  Using S3 with Pro Tools

Track Basics
This section shows how to select, attention, and route tracks to outputs. 

Selecting and Attentioning Tracks
You can select and attention tracks using channel Sel switches. You can use the Modifier switches to select multiple channels. 
When multiple channels are selected, the last selected track is the attentioned track.

To select a track: 

 Press any channel Sel switch. The track is selected in Pro Tools, and that track is attentioned on the S3.

To select all tracks: 

 Hold the Default/ALT Modifier switch and press any unlit channel Sel switch. 

To deselect a track:

 Hold Command and press a lit channel Sel switch.

To deselect all selected tracks:

 Hold Default/ALT switch and press any lit channel Sel switch. 

To select a range of tracks (multi-select):

1 Press the first track’s channel Sel switch (usually the leftmost track you want to include in the selection). 

2 Hold Multi Select/SHIFT and press Sel on the last (right-most) track. All tracks between the two are selected. 

Channel Sel switch (left) and a channel display showing that the corresponding track is attentioned (right)
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To select non-adjacent tracks (add to a selection): 

1 Press the channel Sel switch to select any track. 

2 Hold Command and press an unlit channel Sel switch.

vAdjusting Track Volume and Pan

To adjust track volume:

 Adjust the fader for that track. 

To adjust track pan: 

1 If unlit, press Pan so that it stays lit. 

2 Rotate the encoder below the name of the track you want to pan. Stereo tracks default to left pan. 

3 To adjust right side pan on stereo tracks, press the lit Page > Channel Encoder Navigation switch and rotate the encoder for the 
desired track. The display shows R Pan above stereo tracks and the < Page key lights. 

4 To return to left side pan, press the lit < Page switch. 

To reset pan to 0 (center):

1 If unlit, press Pan so that it stays lit.

2 Press the Channel Encoder below the name of the track you want to reset to center. 

Modifier switches

The standard Pro Tools modifier for parameter reset by holding Option (Mac) or Alt (Windows) can also be used to reset con-
trols. For example, holding Option (Mac) or Alt (Windows) and touching a fader resets the fader to 0/unity. 

Multi Select
SHIFT

Default
ALT

Fine
CTRL Command

Group Channel

Dyn Mix
Insert Pan

Aux Flip

Input EQGain HPF

Comp Pan

Aux Flip

Source
Back

Page Page

Top
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Surround Panning on S3

Use the Channel Encoders or Channel Control to control multichannel pan parameters.

To pan in surround using the Channel Encoders:

1 Select a track assigned to a multichannel output path (such as a 5.1 or 7.1 output path).

2 Press Pan. The first Multichannel pan parameters such as Front Left/Right (for 5.1 outputs) appear on the Channel Encoders.

3 Press the lit Page > switch to show other available pan parameters.

4 Rotate an Encoder to adjust the selected parameter.

5 To reset a parameter to its default setting, press the Encoder for that parameter.

To pan in surround using Channel Control:

1 Select a track assigned to a multichannel output path (such as a 5.1 or 7.1 output path).

2 Press the Channel Control Encoder under the display showing Pan. Multichannel pan parameters appear across Channel Con-
trol.

Record Enabling Tracks
This section explains how to use track and deck record enable commands.

To record enable a track:

 Press the channel Rec switch. The switch flashes red.

To record enable additional tracks:

 Hold SHIFT/Multi Select and press additional channel Rec switches.

To record enable all tracks:

 Hold Alt then press a channel Rec switch.

To use the Touchstrip to control the transport for recording:

1 Press Surface SHIFT + Touch Strip Zone 4 to arm the transport. The Record icon in Pro Tools flashes red.

2 Press Surface SHIFT + Touch Strip Zone 3 to commence recording. 

3 To stop recording, press Surface SHIFT + Touch Strip Zone 3 again.

4 To disarm the transport, press Surface SHIFT + Touch Strip Zone 4.

Flipping Encoder Parameters to Faders
S3 lets you “flip” parameters mapped to the Channel Encoders to the faders and the track level control to the Channel Encoder. The 
following example shows how to flip pan to faders. Flip also works with sends and plug-ins. 

To flip sends to faders: 

1 Select a track that has one or more sends assigned to it. 

2 Press Pan.

3 Press Flip. 

4 Adjust a fader to adjust pan for the corresponding track.

5 Adjust the Channel Encoder to adjust track level for the corresponding track.

6 Press Flip again to flip parameters back to the Channel Encoders.

You can set Pro Tools Preferences for latching record enable, so you don’t have to hold the Shift key to record enable additional 
tracks. For more information, see the Pro Tools Reference Guide.
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Routing Track Input/Output
You can route track I/O using the Channel Encoders or Channel Control.

Using the Channel Encoders

To route track input or output using the Channel Encoders:

1 Do either of the following:

• To assign track input, press Input. 

• To assign track output, press Surface SHIFT + Pan/Mix.

The channel displays show the current input or output assignments for the banked tracks. 

2 Press the Channel Encoder for the track you want to assign. Channel Mode is enabled, and the first three channel displays show 
the available types of input sources or output destinations for the selected track.

3 Press the Channel Encoder under the display showing the desired input or output type.

4 If you select no input, the corresponding Channel Encoder In switch lights. 

5 If you select interface or bus, available hardware inputs or internal busses are shown across the channel displays. Press the 
< Page and/or Page > switches to navigate to other input sources, if available.

6 To assign a track input, press the Channel Encoder under the corresponding display. The Channel Encoder In switch lights when 
that input is assigned.

7 To assign a track output, do one of the following:

• To assign an output pair, press the Channel Encoder In switch under the display showing the desired output pair.

• To assign a mono output, press the Channel Encoder under the display showing the desired output pair to access the individual 
output channels, then press the corresponding Channel Encoder In switch to assign the mono output.

8 To exit assign mode, press Surface SHIFT + Flip/Channel.

Input assignments (left) and output assignments (right) in the channel displays

Input types (left) and output types (right) for the selected track
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Using Channel Control

To assign track input or track output using Channel Control:

1 Select a track. If several tracks are selected, make sure the track you want to adjust is attentioned. 

2 Make sure the top-level Channel Control Knob Set is displayed. Press the Back Channel Control Navigation switch until it is 
displayed.

3 Do either of the following:

• To assign track input, press the Channel Control Encoder under the display showing Input. 

• To assign track output, press the Channel Control Encoder under the display showing Mix.

The leftmost display shows the current input or output assignment for the attentioned track. 

4 Press the Channel Control Encoder under the leftmost display. The first three channel displays show the available types of input 
sources or output destinations for the attentioned track.

5 Press the Channel Encoder under the display showing the desired input type.

6 If you select no input/no output, the corresponding Channel Control Encoder In switch lights. 

7 If you select interface/output or bus, available hardware inputs or internal busses are displayed in the Channel Control displays. 
Press the < Page and/or Page > switches to navigate to other input choices, if available.

8 To assign a track input, press the Channel Control Encoder under the corresponding display. The Channel Control Encoder In 
switch lights when that input is assigned.

9 To assign a track output, do one of the following:

• To assign an output pair, press the Channel Encoder In switch under the display showing the desired output pair.

• To assign a mono output, press the Channel Encoder under the display showing the desired output pair to access the individual 
output channels, then press the corresponding Channel Encoder In switch to assign the mono output.

10 To exit input or output Assign mode, press Back until the top-level Channel Control Knob Set is shown.

Channel Control top-level Knob Set 

Leftmost Channel Control display showing current input assignment for the attentioned track

Channel Controls displays showing available input types
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Multiple Output Path Assignments

You can assign multiple outputs to a Pro Tools track. To assign another track output, simply repeat the previous instructions and 
the new assignment will be added to the current assignments. When a track has multiple output assignments, a plus (+) sign appears 
next to the current track output assignment in the channel display.

Reassigning Track Outputs 

To reassign a track output, you must first assign no output, then assign the new output path. 

Banking Tracks
Bank tracks to the channel strips using the Bank, Nudge, Home, and End switches. You can also bank tracks to channel strips 
using the Bank A–F switches by creating custom Layouts. p-o-[=

To bank tracks to fader strips:

1 Press the Bank > switch to bank the next set of 16 tracks. If tracks 1–16 were assigned to fader strips 1–16, tracks 17–24 are now 
assigned to the 16 fader strips.

2 Press the Nudge > switch to bank tracks one channel to right. If tracks 1–16 were assigned to fader strips 1–16, tracks 2–17 are 
now assigned to the 16 fader strips.

3 Press Home (Surface SHIFT + < Bank) to restore tracks 1–16 to the channel strips. 

4 Press End (SHIFT + Bank >) to bank the last set of tracks to the channel strips.

Storing and Recalling Custom Layouts
Layouts let you assign specific tracks to specific channel strips on the S3, and have those channel strips ignore banking and nudging 
(ensuring that the specific tracks remain available for as long as the Layout is active). You can store Layouts using the Assign and 
Layouts tabs of the EuControl Settings application. Once stored, you can then recall Layouts using the Bank switches A–F. Bank 
switches A–F correspond to Layouts 1–6 respectively. Shift + A–F correspond to Layouts 7–12 respectively. Layouts are saved 
with your Pro Tools session.

Before creating a custom Layout, we recommend saving one “home” Layout so you can quickly return fader strips to standard 
banking.

To create a “home” Layout and save it to Bank switch A:

1 Launch Pro Tools (or another application) and open your session.

2 Click the EuControl icon on the taskbar (Mac) or the System tray (Windows), and select EuControl Settings to open the 
EuControl Settings application.

Channel display showing a track with multiple output assignments

Nudge and Bank switches

Kick
+Out 1-2

1

Mixer Close

Home End
Sel

Nudge Nudge

Bank Bank
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3 Click the Assign tab and make sure Pro Tools (or your other targeted application) appears next to Application. The 16 S3 chan-
nel strips appear in the Strip column, and tracks assigned to each channel strip appear in the Assigned To column.

4 Make sure all strips say <auto assigned> in the Assigned To column. If any are not, click the displayed name in the Assigned 
To column and choose <auto assigned>. 

5 Click the Layouts tab, and double-click the first layout in the list, type in a name, then press Enter.

6 Making sure row 1 is still highlighted, click Store. You can recall your “home” Layout by pressing Bank switch A.

To create a custom Layout on Bank switch B:

1 Click the Layouts tab, double-click row 2, type in a name, and press Enter.

2 Be sure the Layout you have named is highlighted, then click the Assign tab. 

3 Click in the Assigned To column and select a track from the pop-up to assign (lock) that track to the corresponding channel strip. 
Repeat for each available strip.

4 Return to the Layouts tab and click Store. The Layout is saved with your Pro Tools session.

5 On the S3, press Bank switch B to recall the first custom Layout.

You can also press Surface SHIFT + a channel Sel switch to automatically open the Assign tab of EuControl Settings.

Assign tab sowing all Strips are auto-assigned

Enter a name for a Layout

Assigning a track to a channel strip 
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Layouts and Banking/Nudging

Once you recall a Layout, banking or nudging only moves focus by the number of available (<auto assigned>) channel strips. For 
example, if a Layout includes three tracks assigned to strips 1–3, pressing Bank > only banks one strip at a time (since only one 
fader, number 4, is <auto assigned> or “not locked” to a specific track). Note also that it is possible to end up with one track ap-
pearing on and being controllable by more than one strip. In this case, changes made to one strip are reflected in the other. 

Working with Track Groups
You can add and remove tracks to Pro Tools track Groups, and suspend or enable Groups using the Channel Encoders or Channel 
Control on S3.

Using the Channel Encoders

Groups must be created in Pro Tools before they can be accessed and modified on the S3.

To add or remove tracks from a Group using the Channel Encoders: 

1 Press Surface SHIFT + Aux/Group. 

The display shows <All> above each encoder (or the letter designation of the last edited group). All tracks are members of the <All> 
group by default. 

2 Press the lit Page > Channel Encoder Navigation switch to show other available Groups across the display. As you navigate to 
other Groups, Channel Encoder In switches light to indicate track membership in the currently displayed Group. 

3 To add a track to the currently displayed Group, press the Channel Encoder under the displayed Group name. The corresponding 
Channel Encoder In switch lights green showing that track is now a member of the currently displayed Group. 

4 To remove a track from a Group, press the Channel Encoder again so that the Channel Encoder In switch is unlit.

To enable or suspend a track Group:

1 Press Surface SHIFT + Aux/Group. The display shows <All> in every fader display (or, the letter designation of the last edited 
group). 

2 Press the lit Page > switches to show other available Groups across the display. As you navigate to other Groups, the Channel 
Encoder Sel switches (in the encoder row) light to indicate an active (enabled) Group.

3 To enable a Group, press any unlit Channel Encoder Sel switch so it is lit. 

4 To suspend a Group, press any lit Channel Encoder Sel switch so it is unlit. 
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Using Channel Control

To work with track Groups using Channel Control: 

1 Select a track, and make sure it is attentioned.

2 From the Channel Control top-level Knob Set, press the Channel Control Encoder under the display showing Groups. The 
Channel Control displays show the available Groups.

3 To add the track to a Group, press the Channel Control Encoder under the display showing the desired Group so the correspond-
ing Encoder In switch is lit.

• To remove the track, press the Channel Control Encoder so the In switch is unlit.

4 To enable a Group, press any unlit Channel Control Encoder Sel switch so that it is lit. 

• To suspend a Group, press any lit Channel Encoder Sel switch. 

5 To edit another track’s Group properties without returning to the top-level Channel Control Knob Set, just select the channel.

If the top-level Channel Control Knob Set is not shown, press the Back Channel Control Navigation switch until it is shown.
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Working with Plug-Ins
You can assign plug-ins to tracks using Channel Control, and adjust them using the Channel Encoders or Channel Control.

Assigning Plug-Ins
Assign plug-ins to tracks using Channel Control and the Config switch.

To assign a plug-in to a track using Channel Control:

1 Select a track, and make sure it is attentioned.

2 From the Channel Control top-level Knob Set, press the Inserts Channel Control Encoder. 

The Channel Control displays now show the available Inserts slots. If no plug-in is inserted in a slot, the slot letter appears in 
lower-case (a, b, c, and so on) in the corresponding display. If a plug-in is inserted in a slot, the name of the plug-in is shown in the 
corresponding display. Plug-in names are abbreviated as necessary.

3 Press the Config switch so it is lit. CFG appears in each Channel Control display.

4 Press the Channel Control Encoder under the display showing the Inserts slot you want to populate.

5 Press the Encoder under the display showing Plug-In. 

6 Press the Encoder under the display showing the plug-in type you want to insert, such as EQ, Dynamics, or Reverb.

7 Press the Encoder under the display showing the desired plug-in to assign the plug-in.

Adjusting Plug-Ins
Plug-Ins can be accessed and adjusting using the Channel Encoders and Channel Control. You can also access only EQ plug-ins 
or only dynamics plug-ins. Plug-in parameter mapping to the Channel Encoders and the Channel Control Encoders depends on the 
selected Knob Set, as follows:

Inserts Knob Set In the Inserts Knob Set, parameters are mapped according to the manufacturer’s specifications. Parameter map-
ping can vary between plug-ins, even of the same type.

EQ and Dyn Knob Sets In the EQ and Dyn Knob Sets, parameter mappings are standardized across types of plug-ins. For example, 
the threshold controls for two compressor plug-ins from different manufacturers appear on the same encoder.

If the top-level Channel Control Knob Set is not shown, press the Back Channel Control Navigation switch until it is shown.

Insert slots a–c (left-to-right) in Config mode in Channel Control 

Choices shown on your system will vary depending on which plug-ins you have installed, and the Pro Tools setting that or-
ganizes plug-ins by Category or Manufacturer.
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Adjusting Plug-Ins Using the Channel Encoders

To adjust plug-ins on the Channel Encoders using the Inserts Knob Set: 

1 Press Insert. Plug-ins assigned to first Inserts slots (a) for the currently banked channels are shown in the channel displays. If 
no plug-in is inserted in that slot for the corresponding track, the Inserts slot letter is shown.

2 Press the Channel Encoder under the display showing the plug-in you want to access. Channel mode is enabled on the Channel 
Encoders, and the parameters for the selected plug-in on the attentioned track are spilled across the 16 Channel Encoders.

3 Do any of the following to adjust parameters:

• Rotate the Channel Encoder below the desired parameter to adjust its value.

• Press the Channel Encoder In switch to toggle the corresponding parameter on/off, where applicable.

• Press the Channel Encoder Sel switch to toggle a secondary parameter on the Channel Encoder, where applicable.

4 Press the lit < Page > Channel Encoder Navigation switches to access more parameters.

5 Press the Back Channel Encoder Navigation switch to exit that plug-in and Channel mode.

6 Press the lit Page > Channel Encoder Navigation switch to access the next Inserts slots.

To adjust an EQ plug-in on the Channel Encoders using the EQ Knob Set:

1 Select a track, and make sure it is attentioned.

2 Press EQ. Channel mode is enabled on the Channel Encoders, and the parameters for the first EQ plug-in on the attentioned track 
are spilled across the 16 Channel Encoders.

3 Press Pan to exit the plug-in and Channel mode.

To adjust a Dynamics plug-in on the Channel Encoders using the Dyn Knob Set:

1 Select a track, and make sure it is attentioned.

2 Press SHIFT + Inserts/Dyn. Channel mode is enabled on the Channel Encoders, and the parameters for the first dynamics 
plug-in on the attentioned track are spilled across the 16 Channel Encoders.

3 Press Pan to exit the plug-in and Channel mode.

Insert switch (left); Channel displays showing the first Inserts slots for tracks 1–3 

Channel displays in Channel Mode showing EQ parameters, with the attentioned track at the left (“Kick”)
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Adjusting Plug-Ins Using Channel Control

To adjust plug-ins in Channel Control using the Inserts Knob Set: 

1 Select a track and make sure it is attentioned.

2 Press the Channel Control Encoder under the display showing Inserts. The Channel Control displays show the plug-ins that are 
inserted on the attentioned track. If no plug-in is inserted in that slot, the Inserts slot letter is shown.

3 Press the Channel Encoder under the display showing the plug-in you want to access. The parameters for that plug-in are spilled 
across the entire top row of 16 Channel Control Encoders.

4 Do any of the following to adjust parameters:

• Rotate the Channel Control Encoder below the desired parameter to adjust its value.

• Press the Channel Control Encoder In switch to toggle the corresponding parameter on/off, where applicable.

• Press the Channel Control Encoder Sel switch to toggle a secondary parameter on the Channel Encoder, where applicable.

• Press the In Channel Control Navigation switch to bypass the entire plug-in.

5 Press the lit < Page > Channel Control Encoder Navigation switches to access more parameters.

6 Press the Back Channel Control Encoder Navigation switch to exit that plug-in and return to the previous menu, or press 
SHIFT + Back/Top to return to the top-level Channel Control Knob Set.

To adjust an EQ plug-in using the Channel Control EQ Knob Set:

1 Press the Channel Control Encoder under the display showing EQ. The parameters for the first EQ plug-in are spilled across the 
entire top row of 16 Channel Control Encoders.

2 Press the lit < Page > Channel Control Encoder Navigation switches to access more parameters.

3 Press the Back Channel Control Encoder Navigation switch to exit that plug-in and return to the previous menu, or press 
SHIFT + Back/Top to return to the top-level Channel Control Knob Set.

To adjust a dynamics plug-in using the Channel Control Dyn Knob Set:

1 Press the Channel Control Encoder under the display showing Dyn. The parameters for the first dynamics plug-in are spilled 
across the entire top row of 16 Channel Control Encoders.

2 Press the lit < Page > Channel Control Encoder Navigation switches to access more parameters.

3 Press the Back Channel Control Encoder Navigation switch to exit that plug-in and return to the previous menu, or press 
SHIFT + Back/Top to return to the top-level Channel Control Knob Set.

To bypass all plug-ins on a track:

1 Select a track.

2 Press the Channel Control Encoder under the display showing Inserts.

3 Press the In Channel Control Navigation switch so it is unlit to bypass all the plug-ins for the selected track.

If the top-level Channel Control Knob Set is not shown, press the Back Channel Control Navigation switch until it is shown.

Channel Control Navigation In switch
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Working with Sends
This section shows how you can assign and adjust Pro Tools sends. 

Assigning Sends
Use Channel Control to assign sends. You can also assign a send to multiple tracks using the Multi Assign switch (Do to Selected).

To assign a send using Channel Control:

1 Select a track, and make sure it is attentioned.

2 From the Channel Control top-level Knob Set, press the Sends Channel Control Encoder. 

The Channel Control displays now show available Sends slots a–j.

3 Press Config so it is lit. CFG appears in the Channel Control displays.

4 Press an Encoder under the display showing the send you want to assign. The first three Channel Control Encoders now display 
the following output path types:

• no output
• interface
• bus

5 Press the Channel Control Encoder under the display showing the output path type you want to assign to the send. Up to 16 avail-
able output paths at a time are shown in the Channel Control displays. 

6 Navigate to additional output paths by pressing < PAGE or PAGE >, where applicable.

7 To assign an output pair such as a stereo bus, press the Channel Control Encoder In switch under the corresponding display.

8 To assign a mono output, do the following:

• Press the Channel Control Encoder under the display showing the bus pair. Each individual bus is assigned to its own Channel 
Control Encoder.

• Press the Channel Control Encoder In switch under the corresponding display to assign the bus.

9 Press Config so it is unlit to exit Config mode.

If the top-level Channel Control Knob Set is not shown, press the Back Channel Control Navigation switch until it is shown.

Inserts top-level Knob Set in Config mode
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Assigning a Send to Multiple Tracks

To assign a send-in to multiple tracks:

1 Select multiple tracks.

2 Press the Sends Channel Control Encoder. 

3 Press the Config switch so it is lit.

4 Press Multi Assign so it is lit.

5 Press the Channel Control Encoder under the display showing the output path type you want to assign to the send.

6 Press the encoder In switch for the send you want to assign (or press the encoder to access mono sends, then press In). The se-
lected send is assigned to all selected tracks.

Adjusting Sends
You can access and adjust sends using the Channel Encoders or Channel Control.

To access a send using the Channel Encoders: 

1 Bank to the desired track. 

2 Press the Aux Channel Encoder Assign switch. Send assignments in slot a are displayed in the Channel Encoder displays for the 
currently banked channels.

3 To view other sends, press Page > until the desired sends are displayed (such as Bus 1–2). 

To access sends using Channel Control:

1 Select a track.

2 From the top-level Channel Control Knob Set, press the Channel Control Encoder under the display showing Sends. The Chan-
nel Control displays show the send assignments for the send slots on that channel. If a send is not assigned in that slot for the 
selected track, the Sends slot letter is shown.

To adjust send level:

 Rotate the encoder under the display showing the send you want to adjust. 

To mute the send: 

 Press the encoder In switch under the display showing the send you want to mute. When muted, the In switch is unlit; when the 
send is on, the In switch is lit. 

To mute all sends on a track:

 From the top-level Channel Control Knob Set, press the In switch under the displays showing Sends.

-or-

 With Sends spilled to the Channel Control Encoders, press the Channel Control Navigation In switch. 

To toggle the send between pre- and post-fader: 

 Press the encoder Sel switch under the display showing the send you want to adjust. When the send is post-fader, the Sel switch 
is unlit. When the send is pre-fader, the Sel switch is lit. Sends are post-fader by default.

To adjust send pan: 

1 Press the encoder under the display showing the send you want to adjust. If the send is stereo, a single encoder will be mapped 
to send pan (usually encoder eight). If the send is three or more channels (such as LCR, or a 5.1 send), additional send pan pa-
rameters become available in the encoders (such as divergence, center percentage, and other multichannel pan parameters). 

2 Rotate the appropriate encoder. 

Multi Assign can also be used to assign a plug-in to all selected tracks.
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Muting/Unmuting Sends

You can mute/unmute individual sends using the Channel Encoders and Channel Control.

To mute/unmute a send: 

1 Bank to the desired track. 

2 Using the Channel Encoders, do the following:

• Press Aux. 

• Use the < Page and Page > keys to navigate the displays until the desired send is shown. 

3 Using Channel Control, do the following:

• Select a track and make sure it is attentioned.

• Press the Sends Channel Control encoder.

4 Hold the Command + Control Modifier switches and press the encoder Sel switch for the desired send. 

Working with Automation
This section shows many of the ways you can control automation settings using the S3. 

Selecting Track Automation Modes
You can select track Automation Modes using the channel strip REC/AUTO switches and the Function switches. The current Au-
tomation Mode is shown in the corresponding channel display on the S3, and on-screen.

Using the REC/AUTO Switches

REC/AUTO (Surface SHIFT + Rec) lets you cycle through the following automation modes: 

To select the automation mode using the REC/AUTO switches:

1 Hold Surface SHIFT + REC/AUTO on a track. 

2 Press Surface SHIFT + REC/AUTO again to cycle through the following automation modes 

• blank = automation is off

• r = read

• w = write

• rw = read/write

3 To change the automation mode on all tracks, hold Option (Mac) or Alt (Windows) while pressing SHIFT + REC/AUTO. 

4 To change the automation mode on all selected tracks, hold Option + Shift (Mac) or Alt + Shift (Windows) while pressing 
SHIFT+REC/AUTO.
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Using the Function Switches

The following table shows the available automation modes on the Function switches.

To select the Automation Mode using the Function switches:

 Press and hold the Function switch for the desired Automation Mode, then select a channel. 

To select the automation mode on multiple tracks using the Function switches:

1 Select multiple channels.

2 Press and hold Multi-Select/SHIFT+ ALT, then press the switch for the desired Automation Mode.

The Function Switch LED lights whenever its respective automation mode is enabled. In certain automation modes (such as Write) 
the LED flashes.

Shortcuts to Display Automation Playlists 
The following shortcuts let you quickly display the breakpoint automation playlist for a control by clicking it in combination with 
modifier keys on your computer keyboard. 

Waveform View

To show the waveform for a track in the Edit window:

 Hold Control + Command (Mac) or Control + Start (Windows) and press the channel Sel switch. 

Track Volume View

To show volume automation for a track in the Edit window: 

 Hold Command + Control (Mac) or Control + Start (Windows) and touch the track fader. 

Track Pan View

To show track pan automation in the Edit window: 

1 Press PAN to assign pan to the Channel Encoders. 

2 Hold Control + Command (Mac) or Ctrl + Start (Windows) and touch the Pan encoder on a track. 

Switch Automation Function Switch Automation Function 

F1 Write F9 Preview

F2 Read F10 Write to Start

F3 Touch F11 Punch Preview

F4 Off F12 Write to End

F5 Latch F13 Suspend Preview

F6 Auto Match F14 Write to Punch

F7 Trim F15 Write to All/Selected

F8 Automation Window F16 Write to Next

9–16 Toggles switches between banks F1-F8 and F9-F16

Show Me (Eye Icon) Not currently available for S3
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Send Level View

To show Send level automation in the Edit window: 

1 Press AUX to assign sends to the Channel Encoders.

2 If necessary, press the Page > Channel Encoder Navigation switch until the desired Sends slot is displayed.

3 Hold Control + Command (Mac) or Ctrl + Start (Windows) and touch the Send encoder in the desired track. 

Send Pan View

To show Send pan automation in the Edit window: 

1 Press AUX to assign sends to the Channel Encoders. 

2 If necessary, press the Page > Channel Encoder Navigation switch until the desired Sends slot is displayed. 

3 Press the encoder for the desired send. 

4 Hold Control + Command (Mac) or Ctrl + Start (Windows) and touch the Send pan encoder on a track. 

Plug-In Automation
Plug-In Parameters can be enabled for automation from the S3. 

Enabling All Plug-in Parameters for Automation 

To enable all plug-in controls for automation on Artist Mix:

1 Press INSERT.

2 If necessary, press the Page > Channel Encoder Navigation switch until the desired Inserts slot is displayed. 

3 Hold Control + Command + Option (Mac) or Control + Start + Alt (Windows) and press the Channel Encoder In switch under 
the display showing the plug-in for which you want to enable automation. 

Enabling an Individual Plug-In Parameter for Automation

To enable automation for a plug-in parameter:

1 Press INSERT.

2 If necessary, press the Page > Channel Encoder Navigation switch until the desired Inserts slot is displayed, and press the Chan-
nel Encoder under the display showing the plug-in you want to access.

3 If necessary, press the Page > Channel Encoder Navigation switch until the desired parameter is displayed. 

4 Hold Control + Command + Option (Mac) or Control + Start + Alt (Windows) and do one of the following:

• For a continuous plug-in parameter such as a level control, touch the encoder for the desired parameter.

– or –

• For a switch-type parameter such as an In/Out switch, press the Channel Encoder In switch for the desired parameter.

Suspending the Faders
You can suspend the faders so they do not follow any underlying automation for quieter operation during editing or mixdown. This 
does not affect automation, it merely parks the faders so they do not move during playback.

To suspend the faders:

 Hold Surface SHIFT while pressing Solo on the first (leftmost) channel strip.

 Repeat to re-enable the faders. 

Pro Tools provides a preference setting for newly inserted plug-ins to default to all parameters enabled for automation. Go to 
Pro Tools > Preferences > Mixing, and under Automation, select Plug-In Controls Default to Auto-Enabled.
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Chapter 5: S3 Audio I/O Connections

This chapter shows how to use the built-in audio I/O on the S3, including:

Enabling S3 Audio on the Workstation Computer
To use the audio I/O on your S3 with your workstation computer, you must first enable the audio connection on the workstation 
computer. This connection only needs to be enabled the first time you connect the S3 to a particular computer.

To enable S3 audio on your workstation computer:

1 Connect S3 to your workstation computer.

2 Power on S3, and make sure the S3 is in Studio mode.

3 Power on your workstation computer.

4 On your computer, go to Applications > Utilities > Audio MIDI Setup.

5 Fro the Window menu, choose Show Network Device Browser.

6 Click the checkbox next to Avid S3. If more than one device appears and both are checked, deselect the other device. Once 
checked, the S3 appears in the list of available audio devices in the Audio Devices Window of the Audio MIDI Setup.

7 Launch Pro Tools, and from the Setup menu choose Playback Engine.

8 From the Playback Engine pop-up, choose Avid S3:AVB.

9 Choose Setup > IO Setup. Click Default on both the Input and Output tabs, then click OK to close IO Setup.

• Enabling S3 Audio on the Workstation Computer

• S3 Audio Connections Overview

• Accessing Audio Control on the S3

• Connecting and Adjusting Inputs

• Connecting and Adjusting Outputs

• Connecting Hardware Inserts

• Connecting and Adjusting Headphones

• Saving S3 Monitor Settings

Display number 15 on the top row of encoders on the S3 shows the current mode (“Studio” or “Live”) when the S3 is initializing 
after being powered on. See Connecting a Second Workstation for more information.

S3 Surface shown in the Network Device Browser (left) and the Audio Devices Window (right) of the Audio MIDI Setup

For other DAWs, see the documentation for the application to configure its I/O settings.

Choosing the S3 as the Playback Engine for Pro Tools
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S3 Audio Connections Overview
S3 provides four channels of analog inputs to Pro Tools or other Core Audio-compatible applications that support sample rates of 
48 kHz, and four channels of analog outputs for connecting monitors and other outboard audio devices.

1 – Inputs 1–2 (2 x XLR)
Inputs 1–2 are balanced microphone inputs, and are adjusted using the In 1 and In 2 Channel Control Encoders. Phantom power (48 
Volts) and a 20 dB pad are provided on each input. Inputs 1–2 can be linked. See Connecting and Adjusting Inputs for more in-
formation.

2 – Inputs 3–4 (2 x 1/4-inch TRS)
Inputs 3–4 are line-level inputs that accept balanced TRS and unbalanced TS connections. Inputs 3–4 operate at a nominal level of 
+4 dBu, and are adjusted using the Line 3 and Line 4 Global Control Encoders. A 20 dB pad is provided on each input. Inputs 3–4 
can be linked.

3 – Outputs 1–2 (2 x XLR)
MAIN

Outputs 1–2 are the main monitoring output pair for your audio/video application, and operate at a nominal level of +4 dBu. Con-
trols for Outputs 1–2 are linked and are adjusted using the Main Channel Control Encoder. By default the monitor source for Out-
puts 1–2 are Out 1–2 from Pro Tools or other DAWs. Outputs 1–2 are active when Select is highlighted in the MAIN Channel Con-
trol Encoder display. See Connecting and Adjusting Outputs for more information.

4 – Outputs 3–4 (2 x 1/4-inch TRS)
ALT

Outputs 3–4 are an alternate monitoring output pair and operate at a nominal level of +4 dBu. Outputs 3–4 accept balanced TRS 
and unbalanced TS connections. Outputs 3–4 are linked and are adjusted using the ALT Global Control Encoder. By default the 
monitor source for Outputs 1–2 are Out 1–2 from Pro Tools or other DAWs. Outputs 3–4 are active when Select is highlighted in 
the Alt Channel Control Encoder display. Track outputs can also be routed to Outputs 3–4 independently in Pro Tools. 

5 – Headphone Output (1 x 1/4-inch Stereo TRS)
Headphone volume is adjusted using the volume wheel along the front edge of the S3. When the Mon to HP monitor preference is 
enabled, the headphone output mirrors Outputs 1–4 on the S3. Track outputs can also be routed to the Headphone output inde-
pendently, and correspond to Out 5–6 in Pro Tools. See Connecting and Adjusting Headphones for more information

S3 control surface back panel audio connections

The monitor source for the MAIN and ALT outputs can be changed using the Mon Prefs encoder. See Changing the Monitor 
Source for more information.

2

5

14 3
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Accessing Audio Control on the S3
Audio Control–the S3’s built-in I/O controls–are adjusted using Channel Control Encoders 9–16. Audio Control is hidden by de-
fault.

To access Audio Control:

 Simultaneously press the right-side < Page and Page > Channel Control Navigation switches.

Controls for the built-in I/O are assigned to Channel Control Encoders 9–16.

Connecting and Adjusting Inputs
You can adjust inputs using the Channel Control Encoders. You can also link Inputs 1–2 and 3–4 and control each pair using a sin-
gle Encoder and associated switches.

To connect and route a mic or line input: 

1 Connect a microphone to Inputs 1–2; connect a line-level device to Inputs 1–4.

2 In your audio/video application, assign S3 hardware inputs to the desired track(s). In Pro Tools, inputs on the S3 are called In 
1–4 in the Input Path selector.

To adjust outputs:

1 If necessary, access Audio Control by simultaneously pressing the < Page and Page > Channel Control Navigation switches.

2 Do any of the following under the display showing the input you want to adjust:

• To adjust input gain, rotate the encoder. 

• To engage the 20 dB pad, press the corresponding encoder Sel button so it is lit green. Pad is also highlighted in the corre-
sponding display.

• To engage 48v (phantom power) on Mic/Line Inputs 1–2, press the corresponding encoder In switch so it is lit red. 48v is also 
highlighted in the corresponding display.

Right-side < Page > switches

I/O controls in Channel Control

Choosing an S3 Input in Pro Tools

Top

In

Sel

Config
Back

PageExpnd
Page

48v
Pad

48v
Pad

48v
Pad

48v
PadIn 1

10dB
In 2

10dB
In 3

10dB
In 4

10dB
Select
Cut

ALT
-65dB

MON
Prefs

AVB 1-2
MON to HP Cut

MAIN
-65dB

Select
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To link and unlink input pairs:

1 To link input pairs 1–2 or 3–4, press and hold Multi-Select/SHIFT

2 Press the Encoder under the display showing In 1 or In 2 to link 1–2, or In 3 or In 4 to link 3–4.

3 To unlink an input pair, press Multi-Select/SHIFT + the encoder under the display showing In 1-2 or In 3-4. 

Connecting and Adjusting Outputs
You can toggle the monitor source between Outputs 1–2 (MAIN) and Outputs 3–4 (ALT), adjust the monitor level, and dim and 
mute (Cut) the outputs using the Channel Control Encoders. The default source for S3 Outputs 1–4 (and the Headphone output if 
MON to HP is selected) is Out 1–2. However, you can also assign tracks to S3 outputs independently.

You can also sum an output pair to mono and change the monitor source for the outputs.

To connect and route and outputs

1 Connect an audio destination such as audio monitors to Outputs 1–2 (Main) or Outputs 3–4 (Alt).

2 In your audio/video application, assign track outputs to the desired S3 hardware output(s). In the Pro Tools Output Path selector, 
Out 1–2 corresponds to S3 Outputs 1–2 (MAIN), Out 3-4 corresponds to S3 Outputs 3–4 (ALT), and Outs 5–6 correspond to 
the S3 Headphone output.

To adjust outputs:

1 If necessary, access Audio Control by simultaneously pressing the < Page and Page > Channel Control Navigation switches.

2 To adjust an output pair, do any of the following under the display showing the output you want to adjust:

• To make an output pair (Main or Alt) active, press the corresponding encoder Sel button so it is lit. Select is highlighted in 
the corresponding display, and the LED above the display is lit green for the currently selected output pair.

• To toggle an output pair on/off, press the corresponding encoder In switch. The output pair is off (Cut) when the button is lit. 
Cut is highlighted in the corresponding display, and the LED above the display is flashes red.

• To adjust the output level, rotate the encoder. The relative level in dB is indicated in the display.

• To dim the output, press the encoder. Dim is shown in the display, and the LED above the display is lit orange.

Encoder displays showing linked Input controls

Choosing S3 Outputs in Pro Tools

To make both output pairs active, press Multi Select/SHIFT + Encoder Sel of the unselected pair. To make only one output pair 
active, press the desired output pair's Sel switch.

48v
Pad In 1-2

10dB 48v
Pad In 3-4

10dB
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To sum an output to mono:

1 Press and hold Multi-Select/SHIFT.

2 Press the Encoder for the output pair you want to sum to mono. Mono appears in the corresponding display. Mono signals are 
sent equally to each physical output in the pair.

3 Repeat to return to stereo operation.

Changing the Monitor Source
You can change the monitor source for the outputs on the S3 using the Monitor Preferences (Mon Prefs) encoder. 

To change the monitor source:

1 If necessary, access Audio Control.

2 Under the display showing Mon Prefs, press the encoder Sel switch to select an available monitor source as follows:

AVB 1–2 When AVB 1–2 is selected and appears in the display, Out 1-2 from Pro Tools and Core Audio are routed to Outputs 1–4 
on the S3 (and the Headphone output if MON to HP is selected). This is the default monitor source setting for the S3.

In 1–2 When In 1–2 is selected and appears in the display, Inputs 1–2 on the S3 are routed to Outputs 1–4 on the S3 (and the Head-
phone output if MON to HP is selected). Use this to monitor an external source such as an audio interface or other playback device.

In 3–4 When In 3–4 is selected and appears in the display, Inputs 3–4 on the S3 are routed to Outputs 1–4 on the S3 (and the Head-
phone output if MON to HP is selected). Use this to monitor an external source such as an audio interface or other playback device.

Connecting Hardware Inserts
Inputs 3–4 and Outputs 3–4 can be used to insert external hardware on tracks in your application. When inserting hardware, be sure 
to connect the device to matching inputs and outputs on S3. For example, to insert a mono device, connect the input of the device 
to Output 3 on S3, then connect the output of the device to Input 3 on S3.

Connecting and Adjusting Headphones
Use the front panel Headphone volume control to control overall Headphone volume. By default the stereo Headphone output mir-
rors the other outputs on the S3, but this can be disabled.

To toggle Headphone output mirroring:

1 If necessary, assign I/O controls to Channel Control.

2 Under the display showing Mon Prefs, press the corresponding encoder In switch. When Mon to HP is unlit, the Headphone out-
put no longer mirrors Outputs 1–4. 

Mon Prefs encoder and display

In Pro Tools, inserts are defined in the IO Setup. Go to Setup > IO..., then click the Insert tab to define the session insert paths. 
See the Pro Tools Reference Guide for more information.

MON
Prefs

AVB 1-2
MON to HP
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Saving S3 Monitor Settings
You can save the current monitor settings on your S3, including monitor preference settings, and MAIN (Outputs 1–2) and ALT 
(Outputs 1–2) settings.

To save the current monitor settings:

1 Make any desired adjustments to the monitor settings on the S3.

2 Under the display showing Save (the 13th Channel Control display), press the lit Encoder Sel switch. 

Saving Settings...appears in the display until saving is complete. Settings are saved until the next time you save.

Audio Control display showing Save

48v Save
Pad In 4

10dB
MON
Prefs

AVB 1-2
MON to HP
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Chapter 6: EuControl

EuControl is launched automatically upon starting your computer and runs in the background. EuControl is responsible for 
finding, linking, and communicating with all Avid media controllers on the network. 

Accessing EuControl Settings

To open the EuControl Settings window, do one of the following: 

• On Mac, click the EuControl icon on the taskbar and select EuControl Settings.

• On Windows, double-click the EuControl icon in the system tray and select EuControl Settings. If you don't see the EuCo-
ntrol icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons, then dou-
ble-click the EuControl icon.

Only one instance of EuControl can run on a workstation. However, multiple workstations on a single network can each run Eu-
Control. Each EuControl-equipped workstation can connect one S3 on the network.

In this chapter, the tabs in the EuControl software are discussed in the order (left to right) as they appear at the top of the EuControl 
Settings dialog.

Surfaces
The Surfaces tab shows all EUCON controllers on your network and those connected to your instance of EuControl.

All Surfaces
All Surfaces shows all Avid media controllers on the network. A device shown in light gray is already connected either to your own 
or another instance of EuControl running on a different workstation. In both cases, it is not selectable.

Surfaces tab 
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My Surfaces
My Surfaces shows the media controllers connected to your instance of EuControl. 

The top-to-bottom order corresponds to the left-to-right order of the surfaces, respectively. The leftmost surface is assigned to fader 
strip 1. Use the + and – buttons to reorder the list. 

Each media controller can be renamed by double-clicking the existing name and typing a new name.

Add
Click Add to add the selected All Surfaces entry to My Surfaces. This connects the selected Avid media controller to your instance 
of EuControl. You can also click and drag an Avid media controller from All Surfaces to My Surfaces.

Add is disabled if all media controllers in All Surfaces are connected to any instance of EuControl.

Remove
Click Remove to remove the selected surface from My Surfaces and make it available to other instances of EuControl.
Remove is disabled if no surface is selected.

Automatically Add
The Automatically Add menu has two settings that control what happens to stored Surfaces between shutdown and startup.

All Surfaces (Default)

This setting is best used when you are the only person running EuControl in your home or studio. It provides an easy plug-and-play 
experience by automatically adding your All Surfaces list to your My Surfaces list so you never have to manually edit the My Sur-
faces list.

My Surfaces Only 

This setting is useful in facilities where other EuControl users are on your network. When EuControl starts, only the surfaces from 
your My Surfaces list are added. Because a surface can only be claimed by one user at a time, this avoids claiming another user’s 
surfaces.

Update Firmware
Each time a new version of EuControl is installed, it checks each media controller in your system to determine if any firmware up-
dates are required. The firmware is embedded in EuControl so an Internet connection is not required. 

Select each media controller in the My Surfaces list. Click Update Firmware to update their firmware. If a dialog displays a mes-
sage that the firmware is up to date, no further action is necessary.

Follow the instructions in the EuControl dialog box.

• The media controllers must be plugged into a working power source.

• Do not power off any media controllers during the update or attempt to interrupt the update.

• The status for each media controller being updated is displayed on that device as well as in the EuControl dialog.

Show Info
Select a media controller and click Show Info to display the name of the unit, and hardware and software information. 

If you changed the name of the S3 in VENUE software, that name will appear in the My Surfaces list. Likewise, if you changed 
the name in the My Surfaces list, it will appear as such in VENUE software.

One S3 and one Artist Transport can be added to My Surfaces and used simultaneously with Pro Tools or other EUCON-
enabled DAWs.
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Workstations
A media controller can control applications running on a second computer, referred to in this guide as a workstation. The Work-
stations tab establishes the list of workstations that the Workstation switch cycles through. Any workstation running 
EuControl software can be in this list, including those controlled by the System 5-MC, MC Pro, Artist Control, and S3.

All Workstations
All Workstations lists all EUCON-enabled workstations on the network. If the workstation is already in the My Workstations list, 
it is shown in gray and cannot be selected. 

My Workstations
My Workstations lists the workstations that can be attached to by pressing the Workstation switch (Surface SHIFT + Applica-
tion/Workstation).

It is possible to put a workstation in the My Workstations list that is already attached to another instance of EuControl running on 
another computer. It cannot be attached here until it is unattached from the other instance of EuControl. This allows multiple users 
to share workstations without having to frequently edit their My Workstation list.

Add 
Click Add to add the selected workstation from the All Workstations list to the My Workstations list. If the workstation is already 
in the My Workstations list, it is grayed out and cannot be selected. 

Remove
Click Remove to remove the selected workstation from the My Workstations list. 

Workstations tab 
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Attach/Detach
Select a workstation in the My Workstations list and click Attach. A check mark appears in the Attach column next to that work-
station. This workstation is now communicating with the media controller(s) connected to your instance of EuControl. 

If the selected workstation is already attached, the button displays Detach. Click it to detach the workstation. 

Redirect Keyboard and Mouse Control to Attached External Workstation

Your computer keyboard and mouse can control a second external workstation, if desired. Select this option before adding a work-
station to the My Workstations list to redirect keyboard and mouse control to the attached workstation. Note that the keyboard and 
mouse will no longer control your primary workstation. If this option is not selected (default setting), your keyboard and mouse 
control your primary computer.

You can manually toggle control back and forth between your primary workstation and the attached external workstation by press-
ing Control + Option + \ (Mac) or Control+Alt+\ (Windows). 

The Redirect Keyboard and Mouse Control to Attached External Workstation option must be checked before adding the work-
station to the My Workstations list. If it is toggled ON after adding the workstation it will have no affect. Only workstations added 
with the option checked will respond.

General
The General tab lets you control how the S3 and application software work together.

Workstation Tracks Knob Set Changes
This command lets supported workstations follow selection of knob sets on S3. 

Open Plug-ins on Workstation When Editing
This command lets supported workstations open plug-in windows on-screen when a plug-in is selected for editing on S3. 

Close Plug-ins on Workstation When Exiting
This command lets supported workstations close plug-in windows on-screen when you press BACK or exit Inserts mode on an S3. 

General tab
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Select by Touch
This command lets supported workstations attention (focus) tracks on-screen when their fader is touched on the S3. 

Auto-bank to Selected Track
When this is selected, S3 banks to tracks when the tracks are selected on-screen. The surface will auto-bank such that the selected 
track appears on the leftmost fader of the surface as long as the selected track is not currently visible on the surface. 

Display Track Numbers on Surface
When this is selected, S3 shows track numbers as assigned by the current workstation (if supported) in the channel displays. 

Solo Mode
These setting let you configure S3 for the following Solo modes as (if) available in the current workstation: 

• Solo-in-Place

• After-Fader Listen (AFL)

• Pre-Fader Listen (PFL) 

See the documentation for your specific workstation for details on Solo modes. 

Wheel Sensitivity
These options are not applicable for S3.
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Preferences

Footswitch
You can connect a footswitch to S3 for hands-free punch in/out. Connect a footswtich to the 1/4-inch footswitch input on the back 
panel. 

To configure the Footswitch in EuControl: 

 In the Footswitch section of the Preferences tab, click to select the desired Punch In and Punch Out assignments: 

Record | Record 

When the application is rolling, pressing the footswitch once punches into recording on record enabled tracks. Pressing the 
footswitch again takes the track(s) out of record but does not stop the transport. 

Record | Play

Pressing the footswitch once punches into recording on record enabled tracks. Pressing the footswitch again stops the record pass 
(your DAW may or may not automatically take the track out of record on stop; see the documentation for your application). 

Status

Shows whether the footswitch state is currently on or off. 

Shift + Fader Sets Level to 0dB 
When enabled, holding SHIFT and touching a fader sets the fader to 0dB. Surface SHIFT-lock does not apply (Surface SHIFT 
must be pressed). 

Artist Control Display
This feature does not apply to S3.

Display Screen Dim Time
This feature does not apply to S3.

Preferences tab
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Assign
The Assign tab manages how tracks are assigned to S3 channel strips. By default, tracks are automatically assigned in banks of 16. 

Display Application’s Track Numbers 
Enabling this option lets EuControl display track numbers as assigned by the currently selected (in focus) application (if that ap-
plication supports track numbers). 

Clear All Assignments
Clears all currently displayed assignments. 

Lock to Application
This feature does not apply to S3.

Assign tab
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Layouts
Use the Layouts tab to store and recall custom fader layouts. For example, you can use the Assign tab to assign tracks to specific 
S3 channel strips. You can then save those assignments as part of a fader layout on the Layouts tab, which you can then recall using 
the Bank A–F switches. See Storing and Recalling Custom Layouts.

Soft Keys
This feature is not currently available for S3.

Restart EUCON Applications
If you are having trouble connecting your surface to your DAW, use the Restart EUCON Applications command.

To restart all EUCON applications (including EuControl software):

 On Mac, click the EuControl icon on the taskbar and select Restart EUCON Applications, then click Yes.

 On Windows, click the EuControl icon in the Task or System tray (Windows) and select Restart EUCON Applications, then 
click Yes. Unused icons will be shown in the Hidden icons view.

All EUCON applications are restarted, including EuControl.

Layouts tab

Layouts are created and temporarily stored in EuControl as long as the current session or project is open. To be able to re-
call your layouts, be sure to save your session or project in your workstation application. 
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Appendix A: Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste 
equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more 
information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the 
product.

Proposition 65 Warning

Perchlorate Notice
This product may contain a lithium coin battery. The State of California requires the following disclosure statement: 
“Perchlorate Material – special handling may apply, See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

EMC (Electromagnetic Compliance)
This model Artist Mix complies with the following standards regulating interference and EMC:
• FCC Part 15 Class B
• EN 55022 Class B
• EN 55024 Class B
• AS/NZS CISPR 22 Class B
• CISPR 22 Class B

This product contains chemicals, including 
lead, known to the State of California to 
cause cancer and birth defects or other re-
productive harm. Wash hands after handling.
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FCC Compliance for United States

Radio and Television Interference

Australian Compliance

Canadian Compliance
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

CE Compliance
(EMC and Safety)

Avid is authorized to apply the CE (Conformité Europénne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC and Low Voltage 
Directive 2006/95/EC. 

Korean EMC Compliance

이 기기는 가정용 (B 급 ) 전자파적합기기로서 주
로 가정에서 사용하는 것을 목적으로 하며 , 모
든 지역에서 사용할 수 있습니다 .

Safety Compliance

Safety Statement
This equipment has been tested to comply with USA and Canadian safety certifications in accordance with the specifications of UL Standards: UL60950-1:2007, 2nd Edition 
and canadian CAN/CSA C22.2 60950-1-07, 2nd Edition. Avid Inc. has been authorized to apply the appropriate UL and CUL mark on its compliant equipment. 

Communication Statement
NOTE: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular 
installation.  If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try and correct the 
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
Any modifications to the unit, unless expressly approved by Avid, 
could void the user's authority to operate the equipment.
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Warning

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two 
blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for 
replacement of the obsolete outlet.

10) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.

11) Only use attachments/accessories specified by the manufacturer.

12) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is 
used, use caution when moving the cart/equipment combination to avoid injury from tip-over.

13) Unplug this equipment during lightning storms or when unused for long periods of time. 

14) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, 
liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.

15) For products that are a Mains powered device: 
The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment. 

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture. 

16) For products containing a lithium battery: 
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type. 

17) For products with a power switch: 
The main power switch is located on the back panel of S3. It should remain accessible after installation. 

18) The equipment shall be used at a maximum ambient temperature of 40° C.
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Avid
280 N Bernardo Avenue
Mountain View, CA 94043 USA
Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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